Question No: 1 (Marks: 1) - Please choose one
_________ command to resume the execution of a suspended job in the foreground
► fg (Page 68)
► bg
► jobs
► kill

Question No: 2 (Marks: 1) - Please choose one
_________ commands in Linux is used to copy file
► is
► cp (Page 30)
► mv
► mkdir

Question No: 3 (Marks: 1) - Please choose one
The process id returned to the child process after successful fork system call execution is ___________.
► 0  (Page 40)
► 1
► 2
► 3

Question No: 4 (Marks: 1) - Please choose one
In _______ addressing, the recipient is not required to name the sender.
► Symmetric
► Asymmetric  (Page 47)
► Both symmetric and asymmetric
► None of the given options
Question No: 5 (Marks: 1) - Please choose one
A solution to the critical section problem must satisfy the following requirements
► Progress
► Mutual exclusion
► Bounded Waiting
► All of these (Page 101)

Question No: 6 (Marks: 1) - Please choose one
Typically the execlp system call is used after a fork system call.
► True (Page 39)
► False

Question No: 7 (Marks: 1) - Please choose one
You can create a threads by using the pthread_create() call.
► True (Page 76)
► False

Question No: 8 (Marks: 1) - Please choose one
The interval from the time of submission to the time of completion is the ______
► Turnaround time (Page 83)
► Waiting time
► Response time
► None of all these

Question No: 9 (Marks: 1) - Please choose one
Each process must first request permission to enter its critical section. The section of code implementing this request is called the _____
► Entry section (Page 100)
► Critical Section
► Remainder section
► None of all these

Question No: 10 (Marks: 1) - Please choose one
IPC provides a mechanism to allow processes to communicate and to synchronize their actions without sharing the same______
► Address space (Page 46)
► Address Name
► Address ID
► None of all these
Question No: 1 (Marks: 1) - Please choose one
Linux is a version of _______ operating system.

► OS/2
► Windows
► Unix  [click here for detail]
► None of the above

Question No: 2 (Marks: 1) - Please choose one
Current working directory can be accessed using -------- Command.

► . (dot)
► # (hash)
► / (slash)
► ~ (tilt)  (Page 25)

Question No: 3 (Marks: 1) - Please choose one
Mkfifo() is a _______.

► Library Call  (Page 58)
► Command
► Directory
► None of Above

Question No: 4 (Marks: 1) - Please choose one
____ command gives a snapshot of the current processes.

► ps  (Page 66)
► top
► who
► ls

Question No: 5 (Marks: 1) - Please choose one
Time interval when the I/O Devices are accessed is known as --------.

► CPU Burst
► IO Burst  [click here for detail]
► Time Slice
► None of Above
Question No: 6 (Marks: 1) - Please choose one
The process of switching from one process to another is called --------------.

► Context switching  (Page 34)
► scheduling
► quantum period
► latency

Question No: 7 (Marks: 1) - Please choose one
__________ directory includes essential system boot files including the kernel image.

► /bin
► /boot  (Page 26)
► /dev
► /etc

Question No: 8 (Marks: 1) - Please choose one
________ scheduling algorithm is sometimes called shortest remaining time first scheduling algorithm.

► Non-preemptive SJF
► Priority Scheduling
► Preemptive Shortest Job First  (Page 85)
► FCFS

Question No: 9 (Marks: 1) - Please choose one
A semaphore that cause Busy-Waiting is termed as ____________.

► Spinlock  (Page 113)
► Monitor
► Critical region
► Critical section

Question No: 10 (Marks: 1) - Please choose one
Progress and Bounded Waiting are some of the characteristics to solve the critical section problems.

► True  (Page 101)
► False

Question No: 11 (Marks: 1) - Please choose one
In ---------addressing; the recipient is not required to name the sender.

► Symmetric
► Asymmetric  (Page 47) rep
► Both symmetric and asymmetric
► None of the given options
Question No: 12 (Marks: 1) - Please choose one
The execution of critical sections must NOT be mutually exclusive

► True
► False  (Page 100)

Question No: 13 (Marks: 1) - Please choose one
A program in execution is called a _____________.

► Command  
► Process  (Page 31)
► Software
► Compiler

Question No: 14 (Marks: 1) - Please choose one
The critical section problem can be solved by the following except

► Software based solution
► Firmware based solution  (Page 101)
► Operating system based solution
► Hardware based solution

Question No: 15 (Marks: 1) - Please choose one
The bottom layer in the layered approach of Operating System is---------

► User interface
► Hardware  (Page 21)
► Kernel
► None of the given options

Question No: 16 (Marks: 1) - Please choose one
The manual pages can be read in Linux using ____ command.

► man  (Page 27)
► wan
► desc
► help
Question No: 1 (Marks: 1) - Please choose one
The hardware mechanism that enables a device to notify CPU is called an ---------
► Interrupt [click here for detail]
► Signal
► Trap
► Process

Question No: 2 (Marks: 1) - Please choose one
You can display the contents (names of files and directories) of a directory in UNIX/Linux directory structure with the ----------- command.
► ll
► s
► ls (Page 28)
► none of the given options

Question No: 3 (Marks: 1) - Please choose one
The ---------------- system call suspends the calling process.
► fork
► wait (Page 42)
► exec
► exit

Question No: 4 (Marks: 1) - Please choose one
In ----------- addressing, the recipient is not required to name the sender.
► Symmetric
► Asymmetric (Page 47) rep
► Both symmetric and asymmetric
► None of the given options

Question No: 5 (Marks: 1) - Please choose one
-------- command gives a snapshot of the current processes.
► ps (Page 66) rep
► top
► who
► ls
Question No: 6 (Marks: 1) - Please choose one
--------------command to resume the execution of a suspended job in the foreground
► fg (Page 68) rep
► bg
► jobs
► kill

Question No: 7 (Marks: 1) - Please choose one
You can use the -------------- command to display the status of suspended and background processes
► fg
► bg
► jobs (Page 68)
► kill

Question No: 8 (Marks: 1) - Please choose one
You can terminate a foreground process by pressing --------------
► <Ctrl-A>
► <Ctrl-C> (Page 69)
► <Ctrl-Z>
► None of the given options

Question No: 9 (Marks: 1) - Please choose one
A time sharing system is
► Multi tasking
► Interactive
► Multi user
► All of these (Page 9)

Question No: 10 (Marks: 1) - Please choose one
The main characteristic of a Real time system is
► Efficiency
► Large Virtual Memory
► Large secondary storage device
► Usability click here for detail

Question No: 11 (Marks: 1) - Please choose one
Shared libraries and kernel modules are stored in directory
► /bin
► /dev
► /boot
► /lib (Page 26)

Muhammad Moaaz Siddiq – MCS(4th)
Moaaz.pk@gmail.com
Campus:- Institute of E-Learning & Modern Studies (IEMS) Samundari
Question No: 12 (Marks: 1) - Please choose one
________scheduler selects the process from the job pool and put them in main memory.

► Long term (Page 36)
► Short term
► Medium term
► Swapper

Question No: 13 (Marks: 1) - Please choose one
In indirect inter process communication, a sender________mention the name of the recipient.

► do
► do not (Page 47)

Question No: 14 (Marks: 1) - Please choose one
A________ is an integer variable that, apart from initialization is accessible only through two standard atomic operations: wait and signal.

► Semaphore (Page 111)
► Monitor
► Critical region
► Critical section

Question No: 15 (Marks: 1) - Please choose one
A semaphore that cause Busy-Waiting is termed as ______.

► Spinlock (Page 112)
► Monitor
► Critical region
► Critical section

Question No: 16 (Marks: 1) - Please choose one
The execution of critical sections must NOT be mutually exclusive

► True
► False (Page 100) rep

Question No: 17 (Marks: 1) - Please choose one
The performance of Round Robin algorithm does NOT depends heavily on the size of the time quantum.

► True (Page 89)
► False

Muhammad Moaaz Siddiq – MCS(4th)
Moaaz.pk@gmail.com
Campus:- Institute of E-Learning & Modern Studies (IEMS) Samundari
Question No: 18 (Marks: 1) - Please choose one
The following requirement for solving critical section problem is known as ______. “There exists a bound on the number of times that other processes are allowed to enter their critical sections after a process has made a request to enter its critical section and before that request is granted.”

► Progress
► **Bounded Waiting**  (Page 101)
► Mutual Exclusion
► Critical Region

Question No: 19 (Marks: 1) - Please choose one
The critical section problem can be solved by the following except

► Software based solution
► **Firmware based solution**  (Page 101)  rep
► Operating system based solution
► Hardware based solution

Question No: 20 (Marks: 1) - Please choose one
_______ is also called Swapper.

► Swap space
► **Medium term scheduler**  (Page 37)
► Short term scheduler
► Long term scheduler

---

**MIDTERM EXAMINATION**

Spring 2010

CS604 - Operating System

Question No: 1 (Marks: 1) - Please choose one
Linux OS can support multiple users at a time

► **True**  (Page 9)
► False

---

Muhammad Moaaz Siddiq – MCS(4th)
Moaaz.pk@gmail.com
Campus: Institute of E-Learning & Modern Studies (IEMS) Samundari
Question No: 2 (Marks: 1) - Please choose one
The Operating system is a layer of software between _________ and ___________.

- hardware, software application  (Page 21)
- Kernel, hardware
- Dos, Windows
- Windows, Kernel

Question No: 3 (Marks: 1) - Please choose one
The major advantage of multi-programming system is

- More than one jobs can be processed at a given time
- CPU utilization can be increased  (Page 8)
- Jobs can be completed quickly
- All of the options are correct

Question No: 4 (Marks: 1) - Please choose one
The main characteristic of a Real time system is

- Efficiency
- Large Virtual Memory
- Large secondary storage device
- Usability  click here for detail  rep

Question No: 5 (Marks: 1) - Please choose one
Command-line interpreter is also called __________ in some operating systems.

- Kernel
- Shell  (Page 16)
- Signal
- API

Question No: 6 (Marks: 1) - Please choose one
I/O instructions are Privileged Instructions.

- True  (Page 12)
- False

Question No: 7 (Marks: 1) - Please choose one
In Linux directory structure, there is __________ root directory.

- 1  (Page 26)
- 2
- 3
- 4
Question No: 8 (Marks: 1) - Please choose one
Utilities used for system administration (halt, ifconfig, fdisk, etc.) are stored in ___________ directory.
► /dev
► /boot
► /lib
► /sbin  (Page 27)

Question No: 9 (Marks: 1) - Please choose one
rm and [r]mkdir commands are used to ___________ directory.
► Create
► Move
► Remove  (Page 30)
► Modify

Question No: 10 (Marks: 1) - Please choose one
You can use the mv file1 file2 command to move ___________.
► file1 to file2.  (Page 30)
► file 2 to file 1
► this command will not work for moving files
► None of the option is correct.
► Both option a and b are correct

Question No: 11 (Marks: 1) - Please choose one
Taking the CPU from one process and giving the CPU to another process is termed as
► Context Switching  click here for detail
► Dispatching
► Swapping
► Tracking

Question No: 12 (Marks: 1) - Please choose one
A Process that has finished working, as well as its parent process has also finished its execution. In this state the process A will be called as ________ process.
► Child
► Thread
► Zombie
► Fork
Question No: 13 (Marks: 1) - Please choose one
Bounded Buffer is a buffer of __________ size
► variable  
► fixed  (Page 44)

Question No: 14 (Marks: 1) - Please choose one
In ______ communication the process which wants to communicate with the other process must explicitly name the recipient and the sender.
► Direct  (Page 46)
► Indirect
► Automatic
► Self

Question No: 15 (Marks: 1) - Please choose one
In indirect inter process communication, a sender _______ mention the name of the recipient.
► does
► does not  (Page 47) rep

Question No: 16 (Marks: 1) - Please choose one
The returned code to the child process after successful fork system call execution is
► 1
► 2
► 3
► 0  (Page 40) rep

Question No: 17 (Marks: 1) - Please choose one
If the fork system call fails, it returns
► 1
► -1  (Page 40)
► 2
► 0

Question No: 18 (Marks: 1) - Please choose one
When a process opens its first file explicitly it will get descriptor number __________
► 1
► 2
► 3  click here for detail
► 4
Question No: 1  (Marks: 1) - Please choose one
1 MB or 1 megabyte is equivalent to----
► 1024 bytes
► 1024^2 bytes click here for detail
► 1024^3 bytes
► 1000000 bytes

Question No: 2  (Marks: 1) - Please choose one
The bottom layer in the layered approach of Operating System is--------
► Hardware
► User interface
► Hardware (Page 21) rep
► Kernel
► None of the given options

Question No: 3  (Marks: 1) - Please choose one
-----------has a hierarchical file system structure.
► DOS
► Windows
► UNIX (Page 25)
► None of the given options

Question No: 4  (Marks: 1) - Please choose one
You can use the-------command in UNIX to create a directory.
► rmdir
► mkdir (Page 29)
► cp
► gcc
Question No: 5  (Marks: 1) - Please choose one
Files that start with a -------- in UNIX/Linux directory structure are known as hidden files.

► . (dot)  (Page 28)
► # (hash)
► / (slash)
► ~ (tilt)

Question No: 6  (Marks: 1) - Please choose one
The creating process is called a------------- process while the new processes are called the ------------- of that process

► None of the given options
► Children, parent
► Parent, children  (Page 38)
► Zombie, single

Question No: 7  (Marks: 1) - Please choose one
________ buffer places no practical limit on the size of the buffer

► Bounded
► Unbounded  (Page 44)
► Both Unbounded & bounded
► None of the given options

Question No: 8  (Marks: 1) - Please choose one
The ________ are used for communication between related or unrelated processes on the same system or unrelated processes on different systems.

► Pipes
► BSD Sockets  (Page 53)
► Named pipe (FIFO)
► None of the given options

Question No: 9  (Marks: 1) - Please choose one
A______ is an abstract key for accessing a file.

► File descriptor  click here for detail
► Input Redirection
► Output Redirection
► FIFO
Question No: 10  (Marks: 1) - Please choose one
-------- command gives a snapshot of the current processes.
► ps (Page 66)  rep
► top
► who
► ls

Question No: 11  (Marks: 1) - Please choose one
You can display all of the signals supported by your system, along with their numbers, by using the --------- command
► <Ctrl-A>
► fg
► jobs
► kill -l (Page 69)

Question No: 12  (Marks: 1) - Please choose one
The time it takes for the dispatcher to stop one process and start another running is known as the---------.
► Dispatch latency (Page 82)
► Scheduling
► Context switching
► None of the given options

Question No: 13  (Marks: 1) - Please choose one
First-Come, First-Served (FCFS) is a -------------scheduling algorithm.
► preemptive
► non-preemptive (Page 83)
► both preemptive and non- preemptive
► none of the given options

Question No: 14  (Marks: 1) - Please choose one
The Shortest-Job-First Scheduling algorithm can be
► Preemptive only
► non-preemptive only
► preemptive or non-preemptive. (Page 85)
► None of the given options
Question No: 15  (Marks: 1) - Please choose one
Preemptive scheduling is sometimes called shortest-remaining-time-first scheduling.

► First-Come-First-Served (FCFS)
► Round-Robin
► Sorted Job First (SJF)  (Page 85)
► Priority

Question No: 16  (Marks: 1) - Please choose one
The basic purpose of __________ is to help the users to utilize the hardware resources for completing different tasks in a simplified manner.

► Operating system  (Page 6)
► Application software
► All Software
► All of the given

Question No: 17  (Marks: 1) - Please choose one
OS helps manages the following except

► Application software
► Bus speed of the system  Click here for detail
► Memory
► Virtual memory

Question No: 18  (Marks: 1) - Please choose one
_________ scheduler selects the process from the job pool and put them in main memory.

► Long term  (Page 36) rep
► Short term
► Medium term
► Swapper

Question No: 19  (Marks: 1) - Please choose one
A parent process calling __________ system call will be suspended until children process terminates.

► wait  click here for detail
► fork
► exit
► exec
Question No: 20  (Marks: 1) - Please choose one
n-process critical section problem can be solved by using

► The bakery algorithm  (Page 105)
► Determining modeling
► Analytic evaluation
► None of above
Question No: 1 of 10 (Marks: 1) - Please choose one

________ is a piece of code in a cooperating process in which the process may updates shared data (variable, file, database, etc.).

► Critical analysis
► Critical section (Page 100)
► Critical path
► Critical code

Question No: 2 of 10 (Marks: 1) - Please choose one

Round Robin algorithm is similar to __________ scheduling but preemption is added to switch between processes.

► Shortest job first
► Shortest Remaining Time First
► First Come First Server (Page 88)
► None of these

Question No: 3 of 10 (Marks: 1) - Please choose one

DOS is single user operating system.

► True (Page 7)
► False

Question No: 4 of 10 (Marks: 1) - Please choose one

A process is said to be in critical section if it executes code that manipulates shared data.

► True (Page 100)
► False

Question No: 5 of 10 (Marks: 1) - Please choose one

When process opens its first file explicitly it will get descriptor number ______

► 1
► 2
► 3 Click here for detail
► 4
Question No: 6 of 10 (Marks: 1) - Please choose one
A major problem with priority scheduling algorithms is ______.

► Deadlock
► Aging
► Starvation  (Page 86)
► None of these

Question No: 7 of 10 (Marks: 1) - Please choose one
All threads within a process share the ______ address space.

► Same
► Different  (Page 71)

Question No: 8 of 10 (Marks: 1) - Please choose one
_________ displays information about the top processes.

► Is
► Cs
► Top  (Page 67)
► Cd

Question No: 9 of 10 (Marks: 1) - Please choose one
The scheduling of ______ are done by the operating system.

► Kernel threads  (Page 73)
► User level threads
► Both kernel and user level thread
► None of the give option

Question No: 10 of 10  (Marks: 1) - Please choose one
In Unix/Linux, by default the standard output file is attached to the _________

► File
► Screen  (Page 59)
► Printer
► Scanner

Question No: 1 of 10 (Marks: 1) - Please choose one
POSIX is a standard developed by ANSI

► IEEE  (not sure)
► ISO
► ACM

Muhammad Moaaz Siddiq – MCS(4th)
Moaaz.pk@gmail.com
Campus:- Institute of E-Learning & Modern Studies (IEMS) Samundari
Question No: 2 of 10 (Marks: 1) - Please choose one
______________ is the basis of queuing theory which is branch of mathematics used to analyze systems involving queues and servers.

► Little’s Formula (Page 96)
► Deterministic modeling
► Queuing Theory
► Queuing Analysis

Question No: 3 of 10 (Marks: 1) - Please choose one
______________ is a solution to the problem of indefinite blockage of low-priority processes.

► Starvation
► Deadlock
► Aging (Page 87)
► None of these

Question No: 4 of 10 (Marks: 1) - Please choose one
The priority of a process can be changed using __________ command.

► nice (Page 94)
► cmd
► Cat
► grep

Question No: 5 of 10 (Marks: 1) - Please choose one
Batch programs are usually __________ programs.

► Interactive
► Non-interactive click here for detail
► Foreground
► Preemptive

Question No: 6 of 10 (Marks: 1) - Please choose one
A process consists of __________

► One or more threads
► Code
► Data
► All of the given click here for detail

Question No: 7 of 10 (Marks: 1) - Please choose one
/usr/X11R6 is used by the X Window System.

► True (Page 27)
► False
Question No: 8 of 10 (Marks: 1) - Please choose one
command displays the contents of current working directory.
► ls (Page 28)
► Cs
► Mv

Question No: 9 of 10 (Marks: 1) - Please choose one
Linux uses ________ directory to store system configuration files.
► /bin
► /dev
► /boot
► /etc (Page 26)

Question No: 10 of 10 (Marks: 1) - Please choose one
User mode can run the Privileged instructions.
► 1 (Page 11)
► 0

Question No: 1 of 10 (Marks: 1) - Please choose one
If your processor does not have two slots empty in Per Process File Descriptor Table, then your ________ system call will fail.
► Pipe (Page 55)
► read
► write
► open

Question No: 2 of 10 (Marks: 1) - Please choose one
First ________ entries in Per Process File Descriptor Table are used as soon as the process is created.
► 1
► 2
► 3
► 4 (Page 54)

Question No: 3 of 10 (Marks: 1) - Please choose one
The number of processes completed per unit time is called _________.
► Turn around time
► Throughput (Page 83)
► Response time
► Dispatch latency
Question No: 4 of 10 (Marks: 1) - Please choose one
The procedure “The time at which the process finished working MINUS the arrival time of the process MINUS CPU burst for that process” will help calculate the _________.

► on-preemptive Shortest Job First scheduling.
► Preemptive Shortest Job First scheduling.  (Page 85)
► FCFS
► RR Scheduling

Question No: 5 of 10 (Marks: 1) - Please choose one
/opt is used for storage of large applications.
► True  (Page 27)
► False

Question No: 6 of 10 (Marks: 1) - Please choose one
____ is a virtual directory in Linux and Unix.
► /proc  (Page 27)
► /temp
► /ver
► /boot

Question No: 7 of 10 (Marks: 1) - Please choose one
The Home Directory for superuser in Linux and Unix is
► /home
► /root  (Page 27)
► None of the given

Question No: 8 of 10 (Marks: 1) - Please choose one
Linux Treats Devices as Files.
► True  (Page 26)
► False

Question No: 9 of 10 (Marks: 1) - Please choose one
An absolute pathname starts with the root directory (/) and a relative pathname starts with your home directory.

► True  (Page 25)
► False

Question No: 10 of 10  (Marks: 1) - Please choose one
A pathname is the list of directories separated by _________.
► #
► $
► &
► /  (Page 25)
Question No: 1 of 10 (Marks: 1) - Please choose one
_________________ determines How to do something.

► Mechanism (Page 24)
► Policy
► Mechanism and Policy:
► None of the given

Question No: 2 of 10 (Marks: 1) - Please choose one
User Goal of OS is that It easy to use, reliable, safe and fast.

► True (Page 24)
► False

Question No: 3 of 10 (Marks: 1) - Please choose one
We can install and run multiple OS by using VMWare.

► True  click here for detail
► False

Question No: 4 of 10 (Marks: 1) - Please choose one
Mach, MacOS X Server, QNX, OS/2 and Windows NT are examples of OS Based on ______.

► Layered
► Micro Kernal (Page 22)
► Virtual Machine
► None of The Given

Question No: 5 of 10 (Marks: 1) - Please choose one
In Layered Approach of OS, the Layer highest Layer is User Interface layer.

► True (Page 21)
► False

Question No: 6 of 10 (Marks: 1) - Please choose one
In Layered approach of OS, Lowest Layer is known as ________.

► Software Layer
► Hardware Layer (Page 21)
► Lower Level Layer
► None of The Given

Question No: 7 of 10 (Marks: 1) - Please choose one
Operating System is the Manager of Hardware Resources.

► True (Page 6)
► False
Question No: 8 of 10 (Marks: 1) - Please choose one
An operating system is a control program that manages the execution of user programs to prevent errors and improper use of a computer.
► True (Page 6)
► False

Question No: 9 of 10 (Marks: 1) - Please choose one
The bottom-up view is that operating system is a resource manager who manages the hardware and software resources in the computer system.
► True (Page 6)
► False

Question No: 10 of 10 (Marks: 1) - Please choose one
________ determines What will be done.
► Mechanism
► Policy (Page 24)
► Mechanism and Policy
► None of the given

Question No: 1 of 10 (Marks: 1) - Please choose one
copy file1 file2 is an example of ______ OS view.
► Top down (Page 6)
► Bottom Up

Question No: 2 of 10 (Marks: 1) - Please choose one
The Top-down view is that it is a program that acts as an intermediary between a user of a computer and the computer hardware, and makes the computer system convenient to use.
► True (Page 6)
► False

Question No: 3 of 10 (Marks: 1) - Please choose one
Managing Secondary Storage Involves all of the Following except
► Allocating storage space
► Deallocating Storage
► Prevent Overwritting (Page 5)
► Insure integrity of shared data
Question No: 4 of 10 (Marks: 1) - Please choose one
The Purpose of Operating System is to generate Executable Programs and to _______ them.

► Regenerate
► Execute  (Page 5)
► Store
► Remove

Question No: 5 of 10 (Marks: 1) - Please choose one
Users are the People, machines or computers that uses the Hardware resources.

► True  (Page 4)
► False

Question No: 6 of 10 (Marks: 1) - Please choose one
Database, Compiler, Video games are examples of ________.

► Hardware
► Application  (Page 4)
► Operating System
► Users

Question No: 7 of 10 (Marks: 1) - Please choose one
Which of the Following is not an Operating System.

► Linux
► Unix
► Windows Xp
► Database  (Page 7)

Question No: 8 of 10 (Marks: 1) - Please choose one
Operating system enables the user to use the Hardware Resources.

► True  (Page 4)
► False

Question No: 9 of 10 (Marks: 1) - Please choose one
Which of the following is NOT a Hardware Resource.

► CPU
► OS  (Page 4)
► I/O Devices
► Memory
Question No: 10 of 10 (Marks: 1) - Please choose one
Hardware provide basic computing resource.

► True (Page 4)
► False

Question No: 1 of 10 (Marks: 1) - Please choose one
______________ is a preemptive scheduling algorithm.

► First Come First Serve
► Shortest Job First
► Round Robin (Page 89)
► None of these

Question No: 2 of 10 (Marks: 1) - Please choose one
The priorities of processes in the ______ group remain fixed.

► Kernel (Page 93)
► User

Question No: 3 of 10 (Marks: 1) - Please choose one
The process of switching from one process to another is called latency.

► True
► False (Page 34)

Question No: 4 of 10 (Marks: 1) - Please choose one
In Unix/Linux, by default the standard input file is attached to the _________.

► Mouse
► Keyboard (Page 55)
► Light pen
► Joystick

Question No: 5 of 10 (Marks: 1) - Please choose one
The nice value helps in assigning _______ to a process.

► Priority (Page 94)
► Weight
► Time
► Scheduling

Question No: 10 of 10 (Marks: 1) - Please choose one
______________ integer shows the highest priority of a process in CPU scheduling

► Small (Page 86)
► Large
Quiz No.2

Question No: 1 of 10 (Marks: 1) - Please choose one
If a system is not in a safe state, there can be no deadlocks.

► True
► False (Page 137)

Question No: 1 of 10 (Marks: 1) - Please choose one
A dashed line is used to represent a _________ in Resource Allocation Graph.

► Claim edge (Page 138)
► Request edge
► Assignment edge
► Allocation edge

Question No: 1 of 10 (Marks: 1) - Please choose one
The process of holding at least one resource and waiting to acquire additional resources that are currently being held by other processes is known as ________.

► Mutual exclusion
► Hold and wait (Page 131)
► No preemption
► Circular wait

Question No: 1 of 10 (Marks: 1) - Please choose one
In Resource Allocation Graph, A _______ Pi → Rj indicates that process Pi may request resource Rj at some time in the future.

► Claim edge (Page 138)
► Request edge
► Assignment edge
► Allocation edge
Question No: 1 of 10 (Marks: 1) - Please choose one
If the system can allocate resources to each process in some order and still avoid a deadlock then it said to be in ______ state.
► Safe (Page 137)
► Unsafe
► Mutual
► Starvation

Question No: 1 of 10 (Marks: 1) - Please choose one
A condition where a set of blocked processes each holding a resource and waiting to acquire a resource held by another process in the set is termed as ________.
► Deadlock (Page 130)
► Starvation

Question No: 1 of 10 (Marks: 1) - Please choose one
The following is NOT a classical problem of synchronization
► Bounded buffer problem
► Reader writer problem
► Dining philosopher’s problem
► Counting semaphore problem (Page 118)

Question No: 1 of 10 (Marks: 1) - Please choose one
The integer value of ________ semaphores can range over an unrestricted integer domain.
► Counting (Page 117)
► Binary
► Mutex
► Bounded buffer

Question No: 1 of 10 (Marks: 1) - Please choose one
The condition in which a set \{P0, P1… Pn\} of waiting processes must exist such that P0 is waiting for a resource that is held by P1, P1 is waiting for a resource that is held by P2, and so on, Pn-1 is waiting for a resource held by Pn, and Pn is waiting for a resource held by P0. This condition is known as ______________.
► Mutual exclusion
► Hold and wait
► No preemption
► Circular wait (Page 131)
Question No: 1 of 10 (Marks: 1) - Please choose one
You can use the rm file1 command to __________ file1

► Retrieve
► Remove (Page 30)
► Make
► modify

Question No: 2 of 10 (Marks: 1) - Please choose one
The correct command for compiling C program named program.c in Linux environment is

► gcc program.c –o FirstProgram (Page 31)
► gcc –o FirstProgram program.c
► gcc –z FirstProgram program.c
► gcc program.c –m FirstProgram

Question No: 3 of 10 (Marks: 1) - Please choose one
Using __________ system, we can create a new process in Linux.

► Fork (Page 39)
► exec
► wait
► exit

Question No: 4 of 10 (Marks: 1) - Please choose one
Cooperating processes never share any data, code, memory or state.

► True
► False (Page 5)

Question No: 5 of 10 (Marks: 1) - Please choose one
____ command display the status of a process.

► ls
► ps (Page 66)
► gcc
► cat

Question No: 6 of 10 (Marks: 1) - Please choose one
Swapper is also termed as Short term scheduler.

► True
► False (Page 36)
Question No: 7 of 10 ( Marks: 1 ) - Please choose one
_____ system call is used to write to a file or FIFO or any other IPC channel.

- read
- **write** (Page 48)
- open
- fork

Question No: 8 of 10 ( Marks: 1 ) - Please choose one
A Process ‘A’ that has finished working but its parent process has also finished its execution. In this state the process ‘A’ will be called as _____ process.

- Child
- Thread
- **Zombie** (Page 42)
- Fork

Question No: 9 of 10 ( Marks: 1 ) - Please choose one
______________ scheduling allows a process to move between queues.

- Round Robin
- First Come First Serve
- **Multilevel Feedback Queue** (Page 92)
- Shortest Remaining Time First

Question No: 10 of 10 ( Marks: 1 ) - Please choose one
Round Robin algorithm is most suitable for ________.

- Time sharing system (Page 88)
- Real time systems and batch systems
- Running Batch programs
- Expert system

Question No: 1 of 10 ( Marks: 1 ) - Please choose one
Kernel is responsible for scheduling the user level threads.

- True
- **False** (Page 73)

Question No: 2 of 10 ( Marks: 1 ) - Please choose one
A ******* (or an exception) is a software-generated interrupt caused either by an error (division by zero or invalid memory access) or by a user request for an operating system service.

- Interrupt
- **Trap** (Page 10)
- Signal
- Process
Question No: 3 of 10 (Marks: 1) - Please choose one
Which register holds the smallest legal physical memory address for a process?

► Base register (Page 13)
► Limit register
► Status register
► None of the given options

Question No: 4 of 10 (Marks: 1) - Please choose one
The -------- semaphore provides mutual exclusion for accesses to the buffer pool and is initialized to the value 1.

► mutex (Page 118)
► binary
► counting
► none of the given options

Question No: 5 of 10 (Marks: 1) - Please choose one
Binary semaphores are those that have only two values--------

► 0 and n
► 0 and 0
► 0 and 1 (Page 117)
► None of the given options

Question No: 6 of 10 (Marks: 1) - Please choose one
Physical memory is broken down into fixed-sized blocks, called-------- and Logical memory is divided into blocks of the same size, called --------

► Frames, pages (Page 165)
► Pages, Frames
► Frames, holes
► Holes, segments

Question No: 7 of 10 (Marks: 1) - Please choose one
A page table needed for keeping track of pages of the page table is called -----------

► 2-level paging
► Page directory (Page 173)
► Page size
► Page table size

Question No: 8 of 10 (Marks: 1) - Please choose one
The address generated by the CPU, after any indexing or other addressing-mode arithmetic, is called a -------- address, and the address it gets translated to by the MMU is called a -------- address.

► Virtual, physical click here for detail
► Hexadecimal, Binary,
► Valid, invalid
► Physical, Virtual
Question No: 9 of 10 (Marks: 1) - Please choose one
Each page is a power of ------- bytes long in paging scheme.

► 2
► 3
► 4 (Page 167)
► 5

Question No: 10 of 10 (Marks: 1) - Please choose one
Which part of the computer system helps in managing the file and memory management system?

► Operating System (Page 5)
► Device Drivers
► Application Software
► Hardware

Question No: 1 of 10 (Marks: 1) - Please choose one
Which of the following is correct definition for wait operation?

► wait(S) {
while(S<=0)
; /// no o
S--; }
► wait(S) {
S++;
}
► wait(S) {
while(S>=0)
; /// no op
S--; }
► wait(S) {
S--; }

Question No: 3 of 10 (Marks: 1) - Please choose one
In deadlock detection and recovery algorithm, a deadlock exists in the system if and only if the wait for graph contains a ___________

► Cycle (Page 147)
► Graph
► Edge
► Node
Question No: 4 of 10 (Marks: 1) - Please choose one
register contains the size of the process

- Base register
- Index register
- **Limit register** (Page 13)
- Stack pointers register

Question No: 5 of 10 (Marks: 1) - Please choose one
The scheme is not applicable to a resource allocation system with multiple instances of each resource type.

- **Wait for graph** (Page 148)
- Resource allocation graph
- Both Resource-allocation and wait-for graph
- None of the given options

Question No: 6 of 10 (Marks: 1) - Please choose one
algorithm is used in Deadlock avoidance.

- Bakery
- **Banker’s** (Page 139)
- Mutual exclusion
- Safe Sequence

Question No: 7 of 10 (Marks: 1) - Please choose one
What do we name to an address that is loaded into the memory-address register of the memory?

- Logical address
- **Physical address** (Page 155)
- Binary addresses
- None of the given options

Question No: 8 of 10 (Marks: 1) - Please choose one
Cache is non-volatile memory.

- True
- **False** (Page 153)

Question No: 9 of 10 (Marks: 1) - Please choose one
A system call

- **Is an entry point into the kernel code** (Page 18)
- Allows a program to request a kernel service
- Is a technique to protect I/O devices and other system resources
- All of the these
Question No: 10 of 10  ( Marks: 1 ) - Please choose one
The condition where a set of blocked processes each holding a resource and waiting to acquire a resource held by another process in the set, is termed as ________.

► Deadlock  (Page 130)
► Starvation

Question No: 1 of 10 ( Marks: 1 ) - Please choose one
Banker’s algorithm is used for ________________

► Deadlock avoidance  (Page 140)
► Deadlock detection
► Deadlock prevention
► Deadlock removal

Question No: 2 of 10 ( Marks: 1 ) - Please choose one
The __________ requires that once a writer is ready, that writer performs its write as soon as possible, if a writer waiting to access the object, no new readers may start reading.

► first readers-writers problem
► second readers-writers problem  (Page 119)
► third readers-writers problem
► fourth readers-writers problem

Question No: 3 of 10 ( Marks: 1 ) - Please choose one
________________ is an integer variable accessible through wait and signal which are atomic operations.

► Semaphore  (Page 111)
► Mutex
► Busy waiting
► Signal

Question No: 4 of 10 ( Marks: 1 ) - Please choose one
The integer value of ________ semaphores can not be greater than 1.

► Counting
► Binary  (Page 117)
► Mutex
► Bounded buffer

Question No: 5 of 10 ( Marks: 1 ) - Please choose one
Starvation is infinite blocking caused due to unavailability of resources.

► True  (Page 115)
► False
Question No: 4 of 10 (Marks: 1) - Please choose one
Operating System provides services such as Managing Primary and Secondary Storage, Processes and Allowing user to manage his/her files and directories.

► True (Page 5)
► False

Question No: 5 of 10 (Marks: 1) - Please choose one
___________ is used in real time operating systems.

► Non-preemptive scheduling  Click here for detail
► Preemptive scheduling
► Dispatching scheduling
► FCFS scheduling

Question No: 1 of 10 (Marks: 1) - Please choose one
Preventing a condition of ________ to happen, deadlocks can be prevented to happen.

► Critical region
► Circular wait (Page 136)
► Monitors
► Critical section